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Chapter 22
Surface Plots 

Mathcad worksheets can include both two-dimensional plots and th
dimensional plots. Unlike the two-dimensional plots, which work wi
range variables and functions, three-dimensional plots require a ma
of values. This chapter shows how a matrix can be represented as
surface plot in which you see a three-dimensional illustration of its 
values.

This chapter describes how to create, use, and format three-dimens
surface plots. The chapters that follow describe how to work with ot
types of three-dimensional plots.

This chapter contains the following sections:

Creating a surface plot
Basic steps for creating surface plots; procedures for creating surface plots 
for functions of two variables and for creating parametric surface plots.

Resizing surface plots
Procedures for changing the size of surface plots.

Formatting surface plots
Procedures for changing surface plots: setting the viewpoint, size, and mag
nification; adding labels; and formatting lines, colors, and axes.
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Creating a surface plot

To create a surface plot:

■ Define a matrix of values to plot. Mathcad will use the rows and column numb
of the matrix as x- and y-axes. The matrix elements will be plotted as heights abo
or below the xy plane.

■ Choose Graph⇒Surface Plot from the Insert menu. Mathcad shows a box with
a single placeholder, as shown below:

■ Type the name of the matrix in the placeholder. Just as with an equation, Mat
will not process the surface plot until you click outside the plot.

What you see is a visual representation of the matrix. Mathcad draws a perspec
view of the matrix as a two-dimensional grid lying flat in three-dimensional space. E
matrix element is represented as a point at a specified height above or below this
The height is proportional to the value of the matrix element. In the default perspec
the first row of the matrix extends from the back left corner of the grid to the righ
while the first column extends from the back left corner out toward the viewer. 

Mathcad draws lines to connect the points in the plot. These lines define the sur
The perspective for this rendering of the surface depends on the location of the v
with respect to the surface. You can specify this view by changing the plot's tilt o
rotation, as described in “Changing your view of the surface plot” on page 524.

Plotting a function of two variables 

A typical surface plot shows the values of a function of two variables. To see suc
plot, you must first create a matrix that holds the values of the function, then crea
surface plot of that matrix. Here are the typical steps in plotting a function of two 
variables such as that shown in Figure 22-1:

■ Define a function of two variables.
520  Chapter 22  Surface Plots
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■ Decide how many points you want to plot in the x and y directions. Set up range 
variables i and j to index these points. For example, if you want to plot 10 points
each direction, enter:

■ Define  and  as evenly spaced points on the x- and y-axes.

■ Fill the matrix M  with the values of f( ).

■ Choose Graph⇒Surface Plot from the Insert menu.

■ Type M  in the placeholder and click outside the region.

Figure 22-1: Surface plot of a function of two variables.

Creating parametric surface plots

To use Mathcad's surface plot operator to draw parametric surface plots: 

■ Type the names of three matrices having the same number of rows and colu
into the placeholders at the bottom of the surface plot. 

■ Mathcad interprets these three matrices as the x-, y-, and z-coordinates of points on 
a surface and draws this surface from the viewing angle prescribed by the Rot
and Tilt settings. 

The underlying parameter space is a rectangular sheet covered by a uniform me
effect, the three matrices map this sheet into three-dimensional space. For examp
matrices X, Y, and Z defined in Figure 22-2 carry out a mapping that rolls the she
into a tube and then joins the ends of the tube to form a torus.

i 0 9..:= j 0 9..:=

xi yj

xi yj,
Creating a surface plot 521
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Figure 22-2: Parametric surface plots.

You can't convert parametric surface plots into any other type of 3D plot.

Resizing surface plots

To change the size of a surface plot, follow these steps:

■ Click in the surface plot to select it.

■ Move the mouse pointer to one of the three handles along the edge of the su
plot. The pointer will change to a double-headed arrow.

■ Press and hold down the mouse button. While holding down the button, move
mouse. The surface plot region will stretch in the direction of motion.
522  Chapter 22  Surface Plots
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■ Once the surface plot is the right size, let go of the mouse button. 

■ Click outside the surface plot to deselect it.

Formatting surface plots

Mathcad provides many ways to change the way a surface plot looks. These can
categorized in four groups:

■ Viewing characteristics: the type of plot being displayed; the perspective or p
of view from which you see the surface; how “bumpy” the surface looks; and 
presence or absence of borders, enclosing boxes, axes, and coordinate plan

■ Color and line formatting: whether the z-coordinates of the surface are indicated b
shades of gray or by color; whether the surface is opaque or transparent; and w
the surface patches form a smooth surface or form parallel patches.

■ Axis formatting: whether to show tick marks or grid marks on each axis.

■ Title characteristics: how the surface plot will display titles.

To change any of these plot characteristics, start with the 3D Plot Format dialog

■ Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click on 
the plot itself. Mathcad brings up the 3D Plot Format dialog box. The View Pa
of this dialog box is shown below. The remaining three tabs take you to three
additional pages.

■ If necessary, click the tab for the page you want to work with.

■ Make the appropriate changes in the dialog box.

■ To see the effect of your changes without closing the dialog box, click “Apply.” 

■ When you're finished, close the dialog by clicking “OK.” 
Formatting surface plots 523



cept 
lly 

lick 
s tab 

our 
en 0 
well 

 you 
ts 
 of 

et to 
ook 
e on 
.

Changing your view of the surface plot 

The View page of the 3D Plot Format dialog box lets you modify the general 
presentation of your plot. 

To change your plot from a surface plot to another type of 3D plot, click on the 
appropriate button in the Display As group. You can convert any surface plot (ex
for parametric plots) into a contour plot or a 3D bar chart. These plot types are fu
discussed in the corresponding chapters of this User's Guide. You can also display just 
the points making up the surface without displaying the surface itself. To do so, c
on Data Points. You can change how the points look by using the Colors and Line
of this dialog box. 

To change the perspective, or point of view, from which you see the surface of y
plot, adjust the numbers in the Rotation and Tilt text boxes. Use an integer betwe
to 360 degrees. Figure 22-3 shows the effects of varying the rotation and tilt (as 
as the scale) of a surface plot. 

■ Increasing the rotation turns the plot clockwise. When the rotation is set to 0,
look straight down the first column of the matrix. The first row of the matrix poin
to the right. When the rotation is set to 90, you look straight down the first row
the matrix. The first column points to the left. 

■ Increasing the tilt raises you higher above the plot's surface. When the tilt is s
0, you look edge on at the plane of the matrix. When the tilt is set to 90, you l
straight down on the surface. Think of how a mountain range looks when you'r
the ground (tilt equals 0) and when you're flying directly above (tilt equals 90)
524  Chapter 22  Surface Plots
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Figure 22-3: Different views of a surface.

To control how bumpy the plot looks, adjust the magnification of the vertical scale
changing the number in the Vert. Scale text box. This is an integer between 1 and
When the vertical scale is small, the variations in height of the surface will be ba
perceptible. At 100, the variations are shown at full scale. Figure 22-3 shows the e
of varying the scale (as well as the rotation and tilt) of a surface plot. 

To add or remove a border around the surface plot region, click on Show Border i
Frames group to add or remove a check. The border is a two-dimensional frame a
the surface plot region. 

To enclose the surface and the axes within a three-dimensional bounding box, cli
Show Box in the Frames group to add a check. 

You can add back planes to your surface plots: 

■ To show the xy, xz, and yz back planes, click on “Show” in the Back Planes grou

■ To color the surface of the back planes, click on “Fill Color.”

■ To outline the edges of the back planes in a particular color, click on “Edge Co

Figure 22-4 shows a surface plot with a border around it and with back planes sho
and the same plot enclosed within a box without showing back planes.
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Figure 22-4: Using a border or a bounding box on a surface plot.

Changing the shading of the surface

You can often make a surface plot communicate more effectively by using differ
colors to represent different values of z. Alternatively, if you intend to print on a black
and white printer, you can achieve a similar effect by using different shades of gr
represent the different values of z. Use the Color and Lines page of the 3D Plot Form
dialog box.     

To specify the shading of your plot, click the appropriate button in the Shading gr

■ None: The surface won't have any shading, regardless of where it is.
526  Chapter 22  Surface Plots



lues 

will 

cale.

see 
our 
ens, 
 when 
paque.

s any 
cad 

you 
t will 
ret.

out 

ersec-
ing 
■ Grayscale: The largest values of the matrix will be in white and the smallest va
will be in black. Intermediate values will be in shades of gray.

■ Color: The largest values of the matrix will be in red and the smallest values 
be in blue. Intermediate values will range from yellow through green.

Figure 22-5 shows the same surface plot displayed without shading and in grays

Figure 22-5: Surface plots showing display options for lines and meshes.

If you've chosen to leave the surface without shading (“None”), you'll be able to 
through the surface as if it were transparent. Depending on the surface and on y
viewpoint, you may find it distracting to see through the surface. When this happ
you may want to render the surface opaque. Note that this option is unnecessary
a surface is rendered in color or in shades of gray. Such surfaces are inherently o

■ To make the surface opaque, click Hidden Lines to add a check. Mathcad hide
lines that are behind the surface. Such a plot takes longer to draw since Math
has to determine which parts of the surface are concealed. 

■ To make the surface transparent, click Hidden Lines to remove the check. If 
uncheck Hidden Lines, the surface shows lines that are behind it. Such a plo
draw more quickly than if lines were hidden, but it may be more difficult to interp

The upper two surface plots in Figure 22-5 show the same surface with and with
lines showing.

By default, Mathcad overlays a mesh on colored and grayscale surfaces. The int
tions of the lines making up this mesh correspond to the elements of the underly
Formatting surface plots 527
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matrix. Each patch created by this mesh gets a color corresponding to the value 
underlying matrix element. 

As the number of matrix elements increases, this mesh can become so dense th
begins to obscure the colors. When this happens you may want to hide the mes
do so, click Hide Mesh in the Fill Style group to add a check.

Note that Hide Mesh is only available for colored and grayscale plots. Hiding the m
of a plot that doesn't have any shading would make that plot invisible. The lower
surface plots in Figure 22-5 show the same surface plot with the mesh showing 
with it hidden.

By default, the patches making up the surface are free to tilt in whatever directio
necessary to connect them to their neighboring patches. The result is a continuo
surface. In this case, each point at which grid lines intersect is associated with a m
element. This means that for an  matrix, there will be  patch

To constrain these patches to be horizontal, click Patch Plot in the Fill Style grou
regular surface plots and Alternative Mesh for parametric surface plots to add a c
The resultant discontinuous surface shows a patch for each matrix element. This m
that for an  matrix, there will be mn patches.

Figure 22-6 shows an example of the same matrix being plotted with Patch Plot che
and not checked.
 

Figure 22-6: Patch plots.

m n× m 1–( ) n 1–( )

m n×
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Formatting the axes

The Axes page of the 3D Plot Format dialog box lets you modify the format of the a
of your plot. Each axis is described by its own set of check boxes and text boxes
 

Mathcad generates grid lines for surface plots by extending tick marks up and do
the two back planes adjacent to a given axis. Thus, x-axis grid lines represent lines of
constant x drawn on the xz plane and the xy plane, the two orthogonal planes whose
intersections form the x-axis. The y-axis grid lines and z-axis grid lines are defined 
similarly.   

Note that this makes it impossible to draw lines of constant x on only the xz plane. 
Clicking Grid Lines always results in grid lines being drawn on two of the three b
planes.

To choose between using tick marks or grid lines on a selected axis, use the Grid 
check box for that axis. When Grid Lines is checked, Mathcad will extend the tic
marks on the selected axis into grid lines on each adjacent back plane. For exam
checking this on the z-axis will result in lines of constant z on both the yz and the xz 
back planes. If you are showing grid lines, you should seriously consider showing 
planes as well. See “Changing your view of the surface plot” on page 524. Figur
7 shows an example of a surface plot that uses grid lines rather than tick marks.
Formatting surface plots 529
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Figure 22-7: Using the different options for tick marks.

To add or remove numbers for the tick marks on an axis, use the Numbered chec
for that axis. Figure 22-7 shows the differences between having numbers on the
marks and not having numbers.

You can have Mathcad automatically select the number of grid intervals on an ax
you can specify the number yourself. Grid intervals are the spaces between tick m
or grid lines.     

■ To have Mathcad select the number of grid intervals, use the Auto Grid check 
When Auto Grid is checked, Mathcad will automatically select the number of g
intervals on the specified axis.

■ To specify the number of grid intervals on an axis yourself, enter an integer from 1 
to 99 in the No. of Grids text box. This text box is only available when Auto G
is unchecked.

By default, Mathcad autoscales the z-axis according to the range of values in the matr
you are plotting. Sometimes you will want to fix the scaling yourself, for example
you are comparing views of related data or setting up a surface animation seque
To set the z-axis limits manually, click on the Autoscale box in the z-axis column of 
the Axes page to uncheck it. Then enter the maximum and minimum values in the 
Val. and Min. Val. text boxes.

Since a surface plot is made by plotting the elements of a matrix, Mathcad cann
“know” anything about x and y coordinates. By default, the coordinates on the x- and 
y-axes of a surface plot will simply be rows and columns. The Max. Val. and Min. V
text boxes are therefore grayed out on the x- and y-axes for an ordinary surface plot. If
530  Chapter 22  Surface Plots
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you've made a parametric surface plot, however, you will be able to modify the M
Val. and Min. Val for all three axes.

Labeling the surface plot 

The Title page of the 3D Plot Format dialog box, shown below, lets you add and mo
a title for your surface plot. 

To add or edit a title for your surface plot:

■ Type the title for your plot into the Title text box. 

■ To display the title, click on Show Title to insert a check. To conceal the title with
deleting it, click on Show Title to remove the check.

■ To position the title, click on either the Above or Below button. Mathcad places
title either directly above or below your plot. Figure 22-8 shows the options fo
positioning labels on your plot.

■ To change the title's text or position, edit the information in the Title group as
appropriate.

■ Click “OK” to close the dialog box when you have finished.

■ To delete the title, highlight it in the Title text box and press [Del ].

If you initiate this process by double-clicking on the title itself, you'll see an equiva
dialog box.
Formatting surface plots 531



Figure 22-8: Positioning a title on a surface plot.
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